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Introduction

& Important! For the sake of simplicity, 2 one—page document is used in this sample.

This Tutorial describes the creation of a FlexiLayout for a simple registration form. You will learn how to create blocks and elements,
set simple search constraints and describe field locations. The FlexiLayout Studio project with the test images and a ready—made
FlexiLayout can be found in

<disk name>:\\Documents and Settings\All Users\Application Data\ABBYY\FlexiCapture\9.0\Samples\
FlexilayoutStudio\Halloween Form.

This sample document is a typical example of a registration form for which a FlexiLayout must be created. You will go through all the
steps required to create a FlexiLayout that will detect the following elements: Static Text, Character String, Barcode, Text
Fragment, Date, Separator, White Gap and Object Collection.

The ultimate goal is to create a FlexiLayout which will enable ABBYY FlexiCapture to locate the following fields on all the test pages:
NAME
YOUR PLANET NAME
YOUR SPACESHIP NUMBER
DATE YOU ARRIVED AT THE EARTH
YOUR IDENTITY NUMBER ON THE PARTY
YOUR PHOTO IN FANCY DRESS

Additionally, the FlexiLayout must enable FlexiCapture to find a text field in which the guest has entered the information he or she
managed to find about Halloween. Unlike all the above fields, the exact title of this field is not known in advance.

HALLOWEEN REGISTRATION FORM

NOTE: Please remember that this form should be completed by extraterrestrials only

YOUR PHOTO IN FANCY DRESS

NAME: BIG-TROUBLE-AND-EVEN-MORE-THAN-YOU-THINK

YOUR PLANET NAME: PLUTO

YOUR SPACESHIP NUMBER: 000 00 WD 01

DATE YOU ARRIVED AT THE EARTH: 10/ 10/ 2005

YOUR IDENTITY NUMBER ON THE PARTY IS: H " ” |l

784

LA

0098

About some customs:

The Jack-o-lantern custom probably comes from Irish folklore. As the tale is told,aman named Jack,whowas notorious
as adrunkard and trickster,tricked Satan intoclimbing atree. Jack then carved an image of across in the tree's trunk, |
trapping the devil up the tree. Jack made adeal with the devil that,if he would never tempt him again,he would promise |
tolet him down the tree. .
According tothe folk tale,after Jack died,he was denied entrance toHeaven because of his evil ways,but he was also

denied access toHell because he had tricked the devil. Instead,the devil gave him asingle ember tolight his way through

the frigid darkness. The ember was placed inside ahollowed-out turnip tokeep it glowing longer.

The Irish used turnips as their "Jack’s lanterns” originally. But when the immigrants came to America,theyfound that

pumpkins were far more plentiful than turnips. Sothe Jack-O-Lantern in Americawas ahollowed-out pumpkin, lit with

an ember.

Step 1. Creating a new project
[#Note: A project is a set of files created by ABBYY FlexiLayout™ Studio which contains all the data pertaining to a FlexiLayout.
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1. Create a new folder and name it Samplel.
2. Run ABBYY FlexiLayout Studio.
3. Create 2 new project by selecting New Project in the File menu.

T1 ABBYY FlexiLayout Studio 9.0
Fie | Edit View Batch Image FlexiLayout/ Classifier Tools Help

New Project » | EexiayoutProject.. CtrkN || »
Open Project... Ctrl=0 Classifier Project...

Close Project

Open & Add Images...
Save Cirl+5
Save Copy...

Export...

Project Properties...

Recent Projects
Exit

4. In the dialog box that opens, type the name for the project: Samplel.

After you create the project, the Halloween Form folder will contain:
o Samplel.fsp - the file of your project,
o  SamplelBatch - the default folder where all images added to the batch are stored,
o SamplelTemplates — the default folder where the FlexiLayout is stored.

Step 2. Adding images to the batch

[#Note: A batch is a set of test images (pages) to be used for testing and adjusting a FlexiLayout.

Once the new project has been created, you must add the test images to the batch. The images will be used to test and adjust the
FlexiLayout.

1. Click on the Batch tab in the main program window.
2. Select the Open & Add Images command in the File menu or in the local menu.

© 2009 ABBYY. All rights reserved. 4
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T1 sample1 - ABBYY FlexiLayout Studio 9.0 =]

: File Edit View Batch Image FlexiLayout [ Classifier Tools Help
DR YRRY R0 (MLBEmMEMALT”

Bl -EH
Batch [x]
#PageNo. -5 [¥] |,
Match Ctrl+Shift+E
| Open & Add Images...
Open Page
Go to Page... Ctri+G
ijﬂ] Pre-Recognize Shift+E
Floxila Copy Matched Layout to Reference
Assemble to Reference Documents...
= OS Disassemble Reference Documents
on Change Reference Header/Footer...
Delete Pages Ctrl+Del
Delete Page Data... Alt+Del
Propert  1mage Operations r
Name Correct Orientation
Test Element Cirl+T
Test Header
Test Footer

Match Layout

Add im Properties... Alt+Enter from 0

3. In the Open Images dialog box, select the Document per file option and specify the test image files.

Sample 1 images can be found in
<disk name>:\\Documents and Settings\All Users\Application Data\ABBYY\FlexiCapture\9.0\Samples\
FlexiLayoutStudio\Halloween Form\Halloween FormBatch.

The test images you add to the batch will be displayed in the Batch window.

T samplet - ABBYY FlexiLayout Studio 9.0 M=]Fq
: File Edit View Batch Image FexiLayout/Classifier Tools Help
DR YRR92cRE IBDEBEE K AT

¥ - G I

Batch [x]

#PageNo. -5 (%] [ [ [@M.. [ [@Re... [mia

[O1 1 1(H)(F)

[O2 2 1(H)(F)

[O3 3 1(H)(F)

[C14 4 1(H)(F)

[Os 5 1(H(F

[Oe 6 1(MFE v
|LJ i LJ
I Properties
IReady 0 from 6
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[#Note: When adding images, you can specify how reference assembly must be performed. By selecting Document per file, you tell
the program that each image is a separate document. For more information about reference assembly, see the Reference
document assembly section of the help file.

Step 3. Setting the FlexiLayout propetties

By default, the program has named the new FlexiLayout FlexiLayoutl (see the FlexiLayout tab in the FlexiLayout Properties
dialog box).

Tl sample1 - ABBYY FlexiLayout Studio 9.0 E|@|B|
. Fle Edit View Batch Image FexiLayout/ Classifier Tools Help

nea G0

» B

Batch X

wPageNo. -l [=1 |2 |r@ @M. |i@ l#ire.. [m=

FlexiLayout x

50
[] Blocks
= Cif SearchElements
H Header
[F| Footer

Properties - FlexiLayout

Ready Flexilayoutl

[#Note: The error icon next to the SearchElements, means that no elements have so far been created in the FlexiLayout.

We recommend renaming the FlexiLayout and giving it a meaningful name for the sake of convenience.

To set the FlexiLayout properties (these also include the name of the FlexiLayout):

1. Double—click on the name of the FlexiLayout (ie. FlexiLayout1) or right—click on the FlexiLayout and select Properties
in the local menu.

In the Name field, type a new name for the FlexiLayout, eg. RegistrationForm.
Specify the pre—recognition parameters:

From the Text language list, select English as the pre-recognition language (the documents contain text in English).

Select Typographic in the Text type group (this is the default setting), assuming that in this particular case neither
a dot—matrix printer nor a typewriter will be used to fill in the form.

Mode. You can select either Fast or Full pre-recognition mode, depending on the quality of the images to be
processed. Since the sample images are of good quality, contain no noise and almost no small print, select the
default Fast mode. This will speed up pre—trecognition, both when creating the FlexiLayout in FlexiLayout Studio
and when processing it in FlexiCapture.

Multi-page parameters — Our document contains one page. Therefore, specify 1 for Minimal number of pages
and 1 for Maximal number of pages.

© 2009 ABBYY. All rights reserved. 6
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@ Properties of FlexiLayout1

FlexiLayout | Constants

Info
Hame: ‘ FlexiLayoutl
Version: I:l
Comment:

Pre-recognition parameters
Text type:  [V] Typographic Mode: (@) Fast
DMatrix printer CFull
|:| Typewriter
Text languages: | English |E
Fre-recognition area:

[PagelLeft, PageTop, PageRight, PageBottom] HE

Multi-page parameters

Minimum number of pages: | 1 |

Maximum number of pages: ‘ 1 ‘

| ok || concel || appy || e

There is no need to specify the beginning and end of documents, so you can delete the predefined Header and Footer elements
form the list of elements of your FlexiLayout.

[#Note: You can add Header and Footer elements to a FlexiLayout to help the program detect the beginning and end of
documents. If the program fails to find both the Header and Footer elements when matching the FlexiLayout, it will use the
maximum number of pages specified in the FlexiLayout for document separation. For the document in this example, we specified 1
as the maximum number of pages.

Step 4. Pre-recognition

Before you start creating form elements, you need to know which objects on the form can be used as "signposts" when looking for
fields (blocks). These are usually pictures and/or text fragments that are consistently detected during pre—recognition.

To start pre-recognition:

1. Select all the images in the batch.
2. Select the Prerecognize command in the Batch menu or in the local menu of each image.

© 2009 ABBYY. All rights reserved. 7
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File Edit Wiew Batch Image FlexiLayout/ Classifier Tool

>

Extract objects and pt

Properties... Alt+Enter

D&3a B moEm”: "
K -Gk B
Batch X| | Page-[#1.Unmat.. x
#PageNo. - & [#] | [Ea [£1 Linmatohed ~
Match Ctrl+5hift+E =
Open & Add Images...
Go to Page... Cirl+G
5 | | Pre-Recognize Shift+<g M
FlexiLayout- [*] Copy Matched Layout to Reference
= () FlexiLayoutl Aszemble to Reference Documents...
[ Blocks Disassemble Reference Documents
= O SearchElem Change Reference Header/Footer... h
H Header
[ Footer Delete Pages Ctrl+Del P
Delete Page Data... Alt+Del
Image Operations 4 ’
Correct Orientation
Test Element Ctri+T ||
Properties - Page Test Header
Name b Test Footer 2
Numher Match Layout 'SearchElements'

FlexiLayout Studio 9.0 Tutorial

[#Note: If you change images in the batch or add new images, you will need to restart the pre—recognition procedure. If an image has

not been pre-recognized, it will be pre-recognized when matching it with its FlexiLayout.

Step 5. Viewing images and pre-recognition results

Open the first page in the batch:

Double-click on the corresponding line in the Batch window.

or

Select the Open Page command in the Batch menu or in the local menu of the batch.

© 2009 ABBYY. All rights reserved.



FlexiLayout Studio 9.0 Tutorial

T1 Sample1* - ABBYY FlexiLayout Studio 9.0 [_

. Fle Edit WView Batch Image FlexiLayout / Classifier
Daa B  mEmEm”:” "
ARIRITR -
Batch X| | Page-[#1.Unmat.. x
#PageNo. -5 |¥] |[3 |[#~ |#1 Unmatchad ~
g1 Match Ctri+Shift+E El
[E2 Open & Add Images
[ E' 3 P images...
[E4 | Open page
L= Go to Page... rl+
[E5 GotoP Cirl+G
45 | Pre-Recognize Shift+E HJ
FlexiLayout- Copy Matched Layout to Reference
=K@ FlexiLay Assemble to Reference Documents...
[ Bloc Disassemble Reference Documents
=-Cif Sear )
A - Change Reference Header/Footer...  Bmberth
A F Delete Pages Cirl+Del 2strials o
Delete Page Data... Alt+Del
Image Qperations 4 WARTIA
Correct Orientation
Test Element Ctrl=T JANET |
Properties -
Test Header
Name Test Footer ACESE >~
Numher | Match Layout 'SearchElements' L
Open cuIrent | pronarties, . At+Enter 6

The image will be displayed in the Image window in Matched Layout mode.

By default, the pre—recognition results are not displayed on the image.

To view the pre—recognition results:

Select the Show Image Objects command in the Page menu and then select the type of image object you wish to see,

or

ﬂ Sample1* - ABBYY FlexiLayout Studio 9.0

. Fle Edit View
02
IE -

Batch

[# Page No. -
< |

FlexiLayout- [*]

= () FlexiLayoutl
[T Blocks

Properties - Page

=-Cff SearchElements

Fage Properties...

Batch | Image | FlexiLayout / Classifier Tools Help

Match Cirl+E et [ <
Image Window Scale 4 ij

| Show Image Objects > Shovs Al Objects
Select Tool 4 Hide All Objects

= |1|1_'| |Lﬂ Image Operations » | v | Recognized Words
Correct Orientation Recognized Lines
Pre-Recognize shift+E Separators
Barcodes

Raw Objects

I
<

3

show recognized words (use Shift or Ctrl for multiple selection) 1 from &

Click the corresponding icon on the Extracted Objects toolbar.

WODEm G
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[#Note: You can also view all the objects by sclecting the Show All Objects command.

Step 6. Analyzing pre-recognition results and selecting reference
elements

When analyzing the pre-recognition results, you might wish to view different types of objects and images separately.

First, find the objects which have been consistently detected during pre-recognition on each of the test images and which the
program may use as reference elements when looking for fields.

Once you have viewed the pre—recognition results for all the test images, you will notice that:

L. The program has consistently detected all the Text objects corresponding to the titles of the fields, and all the Barcode
objects and Separator objects around the photograph. These objects can be used as reference elements when looking for
the blocks.

2. On images 3, 5 and 6 the program has detected separators that are missing on the other images. These objects cannot be

used as reference elements when looking for the blocks.

3. On images 1 and 6 the program has failed to recognize all parts of the photograph as Image objects of the Picture type. This
means that looking just for a Picture object the program will not find the entire photograph, and you will need to use
additional methods. (They will be described in Step 20: Describing the Photograph field.)

Now you can create and set up the reference elements and specify the search constraints for blocks corresponding for fields to be
search.

Step 7. Creating a form identifier

When processing semi-structured forms in ABBYY FlexiCapture, one would normally wish to exclude forms not belonging to the
current type. One way to identify a form is to mark at least one element as required. A required element must be consistently detected
on all the forms of a given type (otherwise, the program will not be able to match the form and its FlexiLayout). In this particular case,
the form heading (HALLOWEEN REGISTRATION FORM) will make a good identifier element, since it contains distinct text that can
be easily read by the OCR engine.

[#Note: You can specify an identifier element or set of elements in a predefined compound Header clement (not described in this
tutorial).

The form heading will be used solely to identify the form as belonging to the given type. In the FlexiLayout, specify the form heading
as an element of the Static Text type.

To create an ID element:

Click on the FlexiLayout tab in the program main window.

Select SearchElements in the Flexilayout tree.

Select the Elements command in FlexiLayout>Add element>Static Text or in the local menu of the element.
In the Name field, type a name for the element, e.g. IDHeader.

R I

Clear the Optional element box on the General tab to make the form heading a required element.

© 2009 ABBYY. All rights reserved. 10
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¥ Properties of MainGroup.IDHeader

General | Static Text || Search Constraints || Relations || Advanced|

Hame: | IDHeader |

Full name:| MainGroup.IDHeader

Comment:

Search control

() Optional element
Mull hypothesis quality:

(@) Required element

() Prohibited element

Mumber of surviving hypotheses:

Click on the Static Text tab.

¥ Properties of MainGroup.IDHeader

General | Static Text |Search Constraints || Relations || Advanced|

(®) Search text:
HALLOWEEN REGISTRATION FORM =

() Search text from database:

Connection string: | |

Query text: | |

() Search text from file:

| | Browse

|:| Take spaces into account

|:| Max number of
&rrors: INF Permit multiple line
Max error Line break penalty:

percentage:
Permit missing word

Max space length: | 300
. : Iigging word I:l

[ ]whole words only
[ Match case

[ oc J[ concet [ ey ][ vep ]

In the Search text field, type the text to find: HALLOWEEN REGISTRATION FORM.
Judging by the first image in the batch, one can assume that the form heading is written in one line. Therefore, you can type
the heading without spaces to speed up looking for single-line static text.

© 2009 ABBYY. All rights reserved. 11



FlexiLayout Studio 9.0 Tutorial

8. Set the maximum number of errors that may occur in the found text (either in percentage points or as a number). In this
particular case we recommend setting the Max error percentage at 20, allowing 5 errors for 25 characters of the form
heading,

[#Note: The optimal percentage of allowed errors can only be found by trial and error.

Step 8. Testing the identifier element

To check that the program can reliably detect the image object corresponding to identifier element IDHeader, try matching the
FlexiLayout with each image in the batch:

1. Open each image one by one.
2. Select the Match FlexiLayout & Show Hypotheses command in the Page menu or in the local menu of each
image.

If the image and its FlexiLayout have been matched successfully, the program draws a blue frame around the detected element and
the hypothesis which the program formulates about the IDHeader element will be marked with @ in the Tree of Hypotheses. If
you click on the hypothesis, you will see the properties of the hypothesis in the Properties window.

ﬂ Halloween Form - ABBYY FlexiLayout Studio 9.0 ’_r_ ”D|§|
: File Edit View Batch Image FlexiLayout/Classifier Tools Help
nsa B BDEEE (A S wil”
‘ AR = |

Batch X | Page- [# 1. Doc. 1 (MainGroup). Page 1 of 1] - Matched ... x
[#] Page No. -| § |F_—| ||._|::l: |[|£| A £1 Do 1 (MainGroont Pana 1 of 1 _ A
151 v 1 :

[[Hi2 v 2w

< > ) ]

HALLOWEEN REGISTRATION FORM
FlexiLayout »
= O RegistratDnFDrm e YOUR PHOTO IN FANCY DRESS
NOTE:
[ Blocks Blease remember 1hat this form shauld be completed
= Cﬁ ['.-]ainGrDup s by extraterrestriats only : 7
W

Properties - Hypothesis region P 5

Name Value - T fHypoth MainG »
Flement name  MainGroun... (|| '€ OTTYPOmeses THiainkroup
Element name (T IDHeader o
Ready IDHeader dot

Once you have examined the FlexiLayout matching results for all the images, you will see that the program has failed to formulate a
hypothesis for the IDHeader element on image 2. This is because the form heading is written in two lines on this image, whereas you
described the IDHeader as single-line text.

Step 9. Adjusting the properties of the identifier element

For the identifier element to be detected consistently on all the forms, you need to adjust its properties:

L. Open the element's Properties dialog box.
2. Click on the Static Text tab.

© 2009 ABBYY. All rights reserved. 12
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General | Static Text |Search Constraints | Relations | Advanced

(®) Search text:
HALLOWEEN REGISTRATION FORM =

i

() Search text from database:

() Search text from file:

Take spaces into account
|:| Max number of
Max error
percentage:

Max space length: | 300

Permit multiple line

Line break penalty:

[]Permit missing word

[ o]

[ ]whole words only
[ Match case

I OK I ’ Cancel

FlexiLayout Studio 9.0 Tutorial

3. In the Search text field, type the text to find, preserving the spaces: HALLOWEEN REGISTRATION FORM. This means
that the program will look for a phrase which may not be written in one line.

4. Select Allow for spaces and Permit multiple lines to specify that the search phrase may be written on more than one
lines.
5. Set the Line break penalty to 1. This will preserve the quality of the hypothesis when it goes to the next line. If you set a

smaller value, the hypothesis will be penalized.

Now if you try matching the FlexiLayout and the images, the program will detect the identifier element on all the test images.

Step 10. Describing the YOUR PLANET NAME field

The field titles are detected reliably on all the test images and do not repeat on each given form. The order of the fields is the same on
all the forms, even though their exact locations may vary from form to form. This means that for all the fields you can:

1.
2.

To describe the location of the block corresponding to the YOUR PLANET NAME field:

1.

Create Static Text elements to look for the title of the field.

Use the field title to locate Character String, Text Fragment, Barcode ctc. elements, which will then be used to

look for the corresponding fields.

Create blocks (which correspond to fields) and specify their location as coinciding with that of the corresponding

reference elements.

Create an element of the Static Text type and name it PlanetNameHeader. This element will correspond to the

title of the field YOUR PLANET NAME.

Create an element of the Character String type and name it PlanetName. This element will correspond to the

field YOUR PLANET NAME proper.

Create a block of the Text type and name it PlanetName. This block will correspond to the field YOUR PLANET

NAME

© 2009 ABBYY. All rights reserved.
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Step 11. Describing the YOUR PLANET NAME field: PlanetNameHeader
element

Even though the YOUR PLANET NAME field is preceded by the NAME field, the FlexiLayout must first search for the field YOUR
PLANET NAME. This will exclude the ambiguity which may arise if the FlexiLayout looks for the NAME field first. As the word NAME
can be found in both field titles, the program will formulate several hypotheses if you instruct it to look just for the word NAME
without any additional constraints. To avoid this ambiguity, the program must first look for the YOUR PLANET NAME field and only
then for the NAME field. In Step 15 you will impose additional constraints on the NAME field.

To create 2 PlanetNameHeader clement:

1. Create an element of the Static Text type and name it PlanetNameHeader.
Do not clear the Optional element box which is selected by default. Unlike the form heading, which is used as a form
identifier and for this reason was specified as a required element, all the other form elements are assumed to be optional.
This will allow the program to formulate null hypotheses even for those elements for which it fails to find the
corresponding objects on the images.

X

¥ Properties of MainGroup.PlanetNameHeader B

General |StaticTe>€t Search Constraints | Relations | Advanced

HName: | FlanetNameHeader

Full name:| MainGroup.FlanetlameHeader

Comment:

Search control

(@) Optional element

Hull hypothesis quality:

() Required element

(") Prohibited element

Mumber of surviving hypotheses:

| ok || cancel || appy || e

Click on the Static Text tab.

In the Search text field, type the text to search. Since the field title is written in one line on all the test images, you can
type it without spaces: YOURPLANETNAME.

4. Set the Max error percentage to 20, since the field title has more than one word and is fairly long.

Try matching the FlexiLayout with the test images and make sure that the program successfully finds the YOUR PLANET NAME field
on all the images.

© 2009 ABBYY. All rights reserved. 14
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ﬂ Halloween Form - ABBYY FlexiLayout Studio 9.0

Image FlexiLayout / Classifier Tools Help

G HoBEmEE (AM

<

Name
Element name
Element name

Properties - Hypothesis

Value
MainGr...

. File Edit View Batch
nea
‘ U.EH
Batch
[# Page No. -| HHER
TEL v v
ik v ;
e > o
dim
FlexiLayout
= () RegistrationForm
[ Blocks
|

[~

x

>

¥

»

<>

Co»

Page - [# 2, Doc. 2 (MainGroup), Page 1 of 1] - Possible hy... x
NOTE: a3
Please rermember that this farm should be completed —
by extraterrestrials only
NAME: TRES PELOS
I{OURPLANETNAME] SATURN
YOUR SPACESHIP NUMBER: 18877 OF 22 R

< |
Tree of Hypotheses - MainGroup.PlanetNameHe._. x

(T} PlanetNameHe @ ©

&

Ready

element

We assume that the YOUR PLANET NAME field always contains only one line. Since, unlike the field title, the contents of this field is
not fixed, you must define it as a Character String element.

To create the PlanetName element:

1.

Create an element of the Character String type and name it PlanetName.

© 2009 ABBYY. All rights reserved.
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£ Properties of MainGroup.PlanetName

General |Character String | Search Canstraints | Relations | Advanced|

MName: | PlanetMame |

Full name:| MainGroup.Flanetlame |

Comment:

Search control

(@) Optional element

Mull hypothesis quality:

() Required element

() Prohibited element

Mumber of surviving hypotheses:

ok || cancel || mppy || Hep

Click on the Character String tab.

£ Properties of MainGroup.PlanetName

General | Character String |Search Constraints || Relations" Advanced|

(C) Regular expression:

(@) Alphabets:
Character Set Portia... Add...
(JABCDEFGHDKLMNOPQRSTINWY Zabed. .. 100.

Nalats
Lelate

[ ] Allow embedded hypotheses

Percentage of non-alphabet characters:

[ Jwhole words only [ petect words by interword space

Character count: |{ 0,3, 35,100} | E

|{ -1, -1, NF, THF } | E

Max space length: | 300

Word count:

| ok | cancel || appy || Hen

l

FlexiLayout Studio 9.0 Tutorial

Set the alphabet, i.e. all the characters that may be encountered in the names of planets and their satellites. Judging by the
test images, the alphabet consists of English letters and parentheses. To set the alphabet, click the Add button and select the

required characters in the Add New Alphabet dialog box that opens.

[#Note: The selected characters will be displayed in the Character Set column, (Character String tab, Alphabets field).

© 2009 ABBYY. All rights reserved.
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Set the Percentage of alphabet characters to 100. This means that the program will take into account only the
characters of the current element when looking for the object corresponding to PlanetName element.

Edit Alphabet X
0 Unicode: 00BA Code page: |‘u'ufindov.fs‘u'ufestern Europe (1z V|
Character BA[{186) Unicode subrange: |(SE|ECt Unicode subrange) "|

N ( SN =

GH VT )=

g hij -

IR EEEAERE AR CENAEERENLIEREE

w ||t |A A AAAALE|ICIEIEIEIE|T|T[T]T|B|R|O|G[0]8 0= |a|u|u

Ololy|plalalala alale|cle|é|a|a|i|i|i]i fifa|o|a|d|d|=|a]uo|u

Gloly|p|v|Ele|S 32127 |"|-]— it %o| ¢ |+ [€[™

Selected on screen [ selected in totes4 [ 54 Clear All

ABCDEFGHIUKLMNOPQRSTUVWIY Zabedefghijklmnopgrst

Percentage of alphabet characters: 100.

o ][ el |

[#Note: Generally, you can specify several alphabets for one element. In the Percentage of alphabet characters ficld,
specify the maximum percentage of the characters of each alphabet in the element.

Clear the Allow embedded hypotheses box. This will allow the program to formulate hypotheses which have the
maximum length and meet all the search criteria. Otherwise the program may formulate several embedded hypotheses,
each consisting of portions of one of the selected alphabets (taking into account the allowed percentage of non-alphabet
characters).

In the Percentage of non-alphabet characters field set the maximum percentage of non-alphabet characters to 10%. .
[#Note: This value can only be selected by trial and error and can be changed when adjusting the FlexiLayout.

In the String length field, specify this fuzzy range: {0, 3, 35, 100}. This is an estimation of the length of the string of
characters. We assume that the possible names of planets may have from 3 to 35 characters. Any hypotheses outside this
range will be penalized.

[#Note: This value can only be selected by method of trial and error and can be changed when adjusting the FlexiLayout.
In the Total length of spaces field, specify a fuzzy range that estimates the total length of all the spaces between the

characters in the hypothesis (measured in dots, 1 dot = 1/300 inch, which is the default setting). Do not change the default
range of {-1, -1, INF, INF }. This means that there are no constraints on the number of spaces in the hypothesis.

Click on the Relations tab.
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£ Properties of MainGroup.PlanetName

General | Character String | Search Constraints | Relations | Advanced

Mews relation
Relation: ||-Eft of v |
Reference | HE
Element boundary: |<wh0|e> ~ |
Offset: | ] |

Add |:| Preview

Relations:
E.... Relation Reference Element Offset
RightOf MainGroup.PlanetlameHeader 0
Above MainGroup.PlanetlameHeader -100 1
Belowy MainGroup.PlanetlameHeader -100

[ Inearest

I OK I ’ Cancel ] ’ Apply ] ’ Help

Use the PlanetNameHeader element as the reference element for the PlanetName element. The name of the planet will
always be to the right of the field title and will be located on the same level with the title. Therefore, you must specify the
location of the element relative to the title and to the title's top and bottom borders. Otherwise, the program will formulate
valid hypotheses for any text fragment that consists of characters of the set alphabet, even if it is located higher or lower
than the title. to sum up: the program must look for the name of the planet described by the PlanetName element to the
right of the field title specified as the PlanetNameHeader element and located on the same level with the
PlanetNameHeader element.

Specify that the PlanetName element is located to the right of the PlanetNameHeader element.

Select PlanetNameHeader in the Select reference element window. From the Relation drop—down list, select
Rightof and leave the default value of the Offset field equal to 0.

Click the Add button.
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Select Element

X

MainGroup.FlanetNameHeader

@l MainGroup
(T] IDHeader

9] FlanetNameHeader
FlanetMame

oK ] [ Cancel

11.  Specify that the PlanetName element is located not lower than the PlanetNameHeader element.
Select PlanetNameHeader in the Select reference element window. In the Relation drop—down list, select Above
and set Offset to -100 (this value can only be selected by trial and error). This will give the program some leeway when
detecting the position of the element relative to the title. The negative Offset value means that the element is located above
the bottom border of the title. Click the Add button.

12, Specify that the PlanetName element is located not higher than the PlanetNameHeader element.
Select PlanetNameHeader in the Select reference element window. In the Relation drop—down list, select Below and
set Offset to -100 (this value can only be selected by trial and error). This will give the program some leeway when
detecting the position of the element relative to the title. The negative OffSet value means that the element is located below
the top border of the title. Click the Add button.

[#Note: If you select <whole> in the Element border field, positive Offset values allow you to specify only the following
locations: to the right of the right—hand border of the element, to the left of the left—hand border of the element, higher
than the top border of the element, or lower than the bottom border of the element. If you select <top> and <bottom> in
the Element border field, positive Offset values will limit the search area by the top and bottom borders of the element
and exclude hypotheses which go beyond the top and bottom borders of the title of the field.

Step 13. Testing the YOUR PLANET NAME field

To check that the program can correctly find the field described by the PlanetName element, activate the Batch tab in the
FlexiLayout Studio main window and try matching the FlexiLayout with each image in the batch:

1. Open an image.
2. Select the Match FlexiLayout & Show Hypotheses command in the Page menu or in the local menu of each image.

[#Note: To carty out a fast check, select all the required images in the batch and then select the Analyze Selected command in
the local menu of the batch. The results can be viewed in the Image window in Matched Layout mode. To carry out a more
thorough check, which takes more time but allows you to view the formulated hypotheses, select the Match FlexiLayout & Show
Hypotheses command for each open image separately.
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Once you have matched the FlexiLayout with the images, you will see that the YOUR PLANET NAME field corresponding to the
PlanetName element has been found successfully on all the images.

ﬂ Halloween Form - ABBYY FlexiLayout Studio 9.0 s ||D|R|

: Fle Edit View Batch Image FlexiLayout/Classfier Tools Help

- DB2a RO BB @@ (A

| u.RE
Batch X| | Page-[#2 Doc. 2 (MainGroup), Page 1 of 1.] - Matched ... x

[# Page No. | § |3|:E| | [ | ~ by extraterrestrials only ~

[[%1 v..¥ v

<] > o &

o ©
FlexiLayout x o .
PlanetName - NAME: —

3 | > YOUR PLANET NAME: BEATTRIS I—
Properties - Hypothesis 3 | 2
Name value | = | Tree of Hypotheses - MainGroup x

Flement name B PlanetName o =

Ready

Step 14. Describing the YOUR PLANET NAME field: PlanetName block

To create a block corresponding to the YOUR PLANET NAME field:

1. Click on the FlexiLayout tab in the program main window.
Select Blocks in the Flexilayout tree.
Select Add Blocks>Text in the FlexiLayout menu or New>Text in the local menu.

ﬂ Halloween Form - ABBYY FlexiLayout Studio 9.0 _r_ ||D|R|
. Fle Edit View Batch Image Fexilayout/ Classifier Tools Help
=1 LG BOEm@E RJAS 707
- [

Batch X| | Page-[#2 Doc. 2 Page 1of 1. Header, Fo... X
[#] Page No. «| [§ |E| = Please remember that this form shoukd be completed -~
== ¥ by exdiraterrestrials cnly —
] 2

FlexiLayout x
= (O RegistrationForm & =

] [
& O Ma__Add block b [T] Text
(@ | E Table L
g Barcode
- = Build FlexiLayout Cirl+B Checkmark
— _ Save FlexiLayout Checkmark Group [ 2087
Properties -'w =
[ Picture
Name Va...
Non-Recognized
Number of blocks 7 vour ivexmiT 1 £cod 3
I Group =
Number of blocks < >
: EES — [Ell Repeating Group —
Popup menu 'Add block' BIOCKS
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4. In the Properties dialog box that opens, type a name for the block in the Name field, e.g. PlanetName

[#Note: The name of the block need not coincide with the name of the element corresponding to the YOUR PLANET
NAME field, but this is convenient when working with the FlexiLayout.

5. To describe the location of the block, select Source element. Click "..." and specify the PlanetName element as the
source element.

X

¥ Properties of Blocks.Block ?

Text Block |

HName: | Block |

Comment:

|:| Has repeating instances

Region assignment

For layout: | MainGroup A |

(®) Source element

| | (-]

D Expression

ok || cancel || mppy || Hep

Step 15. Describing the NAME field

To describe the location of the block corresponding to the NAME field:

L. Create an element of the Static Text type and name it NameHeader. This element will correspond to the title of the
NAME field.

2. Create an element of the Character String type and name it GuestName. This element will correspond to the NAME
field proper.

3. Create a GuestName block corresponding to the NAME field.
The elements and the block for this field are created as described in Steps 10 to 14 with the following exceptions:

When specifying the search area for NameHeader, specify that it is located above the PlanetNameHeader element. This
will prevent the program from formulating an erroneous hypothesis that contains the word NAME from the YOUR
PLANET NAME title.
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Select Element

X

| MainGroup.FlanetNameHeader

@l MainGroup
(T] IDHeader
6] PlanethameHeader]
FlanetMame
%) NameHeader

o] [ ool ]

Unlike the alphabet of the PlanetName element, the alphabet of the GuestName element must include only English
letters and the " " symbol. In the String Length field, specify the fuzzy interval {0, 0, 50, INF }.

When specifying the search area for the GuestName element, specify the NameHeader element as the reference element.
When creating the GuestName block, specify the GuestName element as the source element.

Step 16. Describing the YOUR SPACESHIP NUMBER field

To describe the location of the block corresponding to the YOUR SPACESHIP NUMBER field:

1. Create an element of the Static Text type and name it SpaceShipHeader. This element will correspond to the title of the
YOUR SPACESHIP NUMBER field.
2. Create an element of the Character String type and name it SpaceShip. This element will correspond to the YOUR

SPACESHIP NUMBER field proper.
3. Create a block and name it SpaceShip. This block will corresponding to the YOUR SPACESHIP NUMBER field.

The elements and the block for this field are created as described in Steps 10 to 14 with the following exceptions:

Unlike for the PlanetName element, specify a regular expression for the SpaceShip element rather than an alphabet. This
is necessary because the format of data in the YOUR SPACESHIP NUMBER field is the same on all the test images.

The format of spaceship numbers can be defined using the following regular expression:

[0-9]{5}A-Z][A-Z][0-9]{2} (for more on regular expressions see the help file for ABBYY FlexiCapture)
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£ Properties of MainGroup.SpaceShip 2 g|

General | Character String |Search Constraints | Relations | Advanced

(®) Regular expression: | [0-9]{5}[A-Z][A-Z][0-0]{2}
() Alphabets:
Character Set Portio...

Percentage of non-alphabet characters: |:|

[ Jwhole words only [ petect words by interword space
Max space length: | 300 I:l
Character count: |{ -1, -1, INF, INF ¥ | E

word count: ({1, -1, INF, TNF } (-]

I 0K I ’ Cancel

When defining the search area for the SpaceShip element, specify the SpaceShipHeader element as the reference
element.

When creating the SpaceShip block, specify the SpaceShip element as the source element.

Step 17. Describing the DATE YOU ARRIVED AT THE EARTH field

To describe the location of the block corresponding to the DATE YOU ARRIVED AT THE EARTH field:

1. Create an element of the Static Text type and name it DateHeader. This element will correspond to the title of the DATE
YOU ARRIVED AT THE EARTH field.

2. Create an element of the Date type and name it ArrivalDate. This element will correspond to the DATE YOU ARRIVED
AT THE EARTH field proper.

3. Create a block and name it ArrivalDate. This block will correspond to the DATE YOU ARRIVED AT THE EARTH field.
The elements and the block for this field are created as described in Steps 10 to 14 with the following exceptions:

Unlike for the PlanetNameHeader element, enter the text in the Search text field with spaces: DATE YOU ARRIVED
AT THE EARTH. Select the Allow for spaces and Permit multiple lines options and set Line break penalty to 1.
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¥ Properties of MainGroup.DateHeader

General | Static Text |Search Constraints || Relations || Advanced|

(®) Search text:
DATE YOU ARRIVED AT THE EARTH: =

() Search text from database:

() Search text from file:
Take spaces into account
DMax number of
&rrors: I:I [+] Permit multiple line
Max error Line break penalty:

percentage:

[]Permit missing word

Max space length: | 300 I:l

[ ]whole words only
[ Match case

I 0K I ’ Cancel Apply

For the DATE YOU ARRIVED AT THE EARTH field, create an element of the Date type and name it ArrivalDate. For the
ArrivalDate element, specify all the possible date formats on the Date tab. We assume that months will always be written
in digits, and the year will always be a 4—digit number. Clear the Word box in the Month group and the Two digits box in
the Year group. Other options may be left unchanged.

i# Properties of MainGroup.ArrivalDate

| General| Date |Search Constraints || Relations” Advanced|
Format
Date  [v]Day, month, year Month ] Allaw single digit
[Imonth, day, year [¥] Twio digits only
[]vear, day, month [ ]waord
|:|Year, manth, day
Day  []Allow single digit Year [ |Twao digits
[#] Two digits only Four digits
Date interval
from: |14.DQ.1?52 hd to: |31.12.9999 hd
Language:
Separators: | =/
Max space length:
(o J( =]

When defining the search area for the ArrivalDate element, specify the DateHeader element as the reference element.
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When creating the ArrivalDate block, specify the ArrivalDate element as the source element.
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Step 18. Describing the YOUR IDENTITY NUMBER ON THE PARTY

field

To describe the location of the block corresponding to the YOUR IDENTITY NUMBER ON THE PARTY field:

1. Create an element of the Static Text type and name it BarcodeHeader. This element will correspond to the title of the
YOUR IDENTITY NUMBER ON THE PARTY field.
2. Create an element of the Barcode type and name it IdentityNumber. This element will correspond to the YOUR

IDENTITY NUMBER ON THE PARTY field proper.
3. Create a block and name it IdentityNumber. This block will correspond to the YOUR IDENTITY NUMBER ON THE

PARTY field.

The elements and block for this field are created as described in Steps 10 to 14 with the following exceptions:

For the YOUR IDENTITY NUMBER ON THE PARTY field, create an element of the Barcode type and name it
IdentityNumber. For the IdentityNumber element, specify the type of barcode (EAN13) and its orientation (Left-to-
Right) on the Barcode tab.

) Properties of MainGroup.IdentityNumber

Barcode type

[ fcheck Code 32

Codabar

Code 39
Code 39
Code 93
EANLZ
EANS
IATA 25
Industria

Patch Co
FDF417
Fostnet
UCC-128
UPC A
UPC E

CETT T T T T T T TISI T T 1T

Check Interleaved 25

Code 128

without asterisk

|25

Interleaved 25
Matrix 25

de

l Select All HDeseIectAII I

o J[Ccoet |

General | Barcode | Search Constraints | Relations | Advanced

Orientation
Left-to-Right
|:| Bottom-to-Top
[Jright-to-Left

DTDp'tD'BDttDm

When creating an IdentityNumber block, specify the IdentityNumber element as the source element.

Step 19. Describing the ANY TEXT field

The field located at the bottom of the form has no fixed title. Therefore, objects other than titles must be used to locate this field. We
will assume that each ANY TEXT field has its own unique title.

© 2009 ABBYY. All rights reserved.
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First, try using the already created IdentityNumber element to look for the ANY TEXT field, because on all the test images the ANY
TEXT field is located below this element.

[#Note: Do not usc separators that are present on some images, as those are not regular and reliable elements.

To use the IdentityNumber element to find the object corresponding to the ANY TEXT field:

L. Create an element of the Text Fragment type and name it TextField. This element will correspond to the ANY TEXT
field.
2. On the Relations tab, describe the location of the TextField element as Below the IdentityNumber clement.

Tty finding the ANY TEXT field using the IdentityNumber element. You will see that on some images the hypothesis will also
include barcode digits. Therefore, you need to describe the location of the ANY TEXT field more precisely.

Create 2 White Gap element with horizontal orientation. This element will correspond to the gap between the text and the barcode.
This element will be used as a reference element when looking for the ANY TEXT field.

Be sure to place the White Gap element above the TextField element in the elements tree!

1. Create an element of the White Gap type and name it BetweenGap.
2. On the White Gap tab, select Horizontal as the orientation of the BetweenGap.

% Properties of MainGroup.BetweenGap

General | White Gap |Search Constraints | Relations | Advanced

QOrientation

(O vertical (@) Herizontal Min height:

Search among objects of type:

[] Text [] checkmark
|:| Punctuation mark D Separator
[Iricture [ JBarcode

[Jinverted text

Moise
Lower threshold limit:

Upper threshold limit: 130

[
L
!I"wl

Threshold coefficient {%):

[ oK ] [ Cancel

3. On the Relations tab, specify the search area for the BetweenGap element as an area below the IdentityNumber
element but no further than 200 dots from the bottom edge of the BarcodeHeader element.
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—
% Properties of MainGroup.BetweenGap 9
General | White Gap | Search Constraints | Relations | Advanced
Mew relation
Relation: |LEft of v |
Reference | “E
Elernent boundary: |<whn|e> A |
Offset: | ] |
Add |:| Freview
Relations:
E.... Relation Reference Element Offset
Below MainGroup.Identitylumber 0
Above MainGroup.BarcodeHeader.Bottom -200 1
|:| Nearest
[ oK ] [ Cancel ] l Apply I l Help
4. Create an element of the Text Fragment type and name it TextField.
5. On the Relations tab, describe the location of the TextField element as Below the BetweenGap clement, Offset=0.

Try matching the FlexiLayout with all the test images. You will see that the formulated hypothesis about the TextField element does
not contain any unwanted data. This means that the BetweenGap element can be used to detect the TextField element.

specify the TextField element as the source element.

To describe the location of the block corresponding to the ANY TEXT field, create a block of the Text type, name it TextField and

Step 20. Describing the YOUR PHOTO IN FANCY DRESS field

As has been noted in Step 6, not all the parts of the photo on images 1 and 6 were recognized as the Image Object of the Picture

type.
To get a full photo, the program needs to find all the types of Image Object located in the photo area.

For the sake of convenience, group all the photo elements in one compound Photo element. This will also limit the number of

formulated hypotheses.

© 2009 ABBYY. All rights reserved.
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#% Properties of MainGroup.Photo 2

X

General |Search Constraints | Relations || Advanced

Hame: | Photo

Full name:| MainGroup.Photo

Comment:

Search control

(" Optional element

]

(@) Required element

(") Prohibited element

Mumber of surviving hypotheses:
Min number of found subelements: I:|

o ] o ]

The compound Photo element (of the Group type) will include:

. a PhotoPicture element of the Object Collection type corresponding to the photo;
. a PhotoHeader element of the Static Text type corresponding to the title YOUR PHOTO IN FANCY DRESS;
) four separators around the photo which are required for finding the PhotoPicture element.

As the text of the title (namely, YOUR PHOTO IN FANCY DRESS) occurs nowhere else in this document, we added the
corresponding element first and will search for the separators relative to this element.

To create an element corresponding to the field title:
1. Create an element of the Static Text type and name it PhotoHeader.
2. The properties of the element are set similarly to the other field titles as described above.

Try matching the FlexiLayout with the images. You will see that the program reliably detects the title on all the images.

Create Separator elements for the four separators around the photo and give them the following names:
USeparator — upper separator
BSeparator — lower separator
LSeparator — left separator
RSeparator - right separator

On the Separator tab in the Properties dialog box, specify the orientation of each of the 4 separators (Vertical or Horizontal).
Do not change the other properties.
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¥ Properties of MainGroup.Photo.USeparator

General | Separator | Search Constraints | Relations | Advanced

Orientation
(O vertical (@) Horizontal
Min length: 400
Max length: 700
Min relative length (%): 0.
Penalty limit for length: 0.9

Fits entirely within search area

Space
Max length: il
Max relative length (%a): 100.
Orthogonal shift: 0

I 0K I ’ Cancel

Now use the test images to specify the search area for each of the separators.
Upper separator (USeparator element):

below the photo caption but not farther than 100 dots from its top border (Below the PhotoHeader element and
Above the PhotoHeader, Offset = —100, Element Border = top).

within the area which is not longer than the length of the caption by more than 80 dots on each side (Leftof the
right border of the PhotoHeader element, Offset = —80, Element Border = right and Rightof the left border of
the PhotoHeader clement, Offset = —80, Element Border = left).

Lower separator (BSeparator clement):

below the title of the NAME field (Below the NameHeader element),

above bottom of IdentityNumber (Above the IdentityNumber clement, Element Border = bottom).

within the area which is not longer than the length of the title by more than 80 dots on each side (Leftof the right
border of the PhotoHeader element, Offset = —80, Element Border = right and Rightof the left border of the
PhotoHeader clement, Offset = -80, Element Border = left).

Left separator (LSeparator clement):

within the area which is not wider than the distance between the upper and lower separators by more than 50 dots
on each side (Below the USeparator clement, Offset = —50, and Above the BSeparator element, Offset = —50).
the separator is located not far from the left border of the upper separator, the distance cannot exceed 40 dots
(Rightof the left border of the USeparator element, Offset = -20, Element Border = left, and Leftof the left
border of the USeparator element, Offset = —20, Element Border = left).

Right separator (RSeparator element):

within the area which is not wider than the distance between the upper and lower separators by more than 50 dots
on each side (Below the USeparator clement, Offset = —50, and Above the BSeparator element, Offset = -50).
the separator is located not far from the right edge of the upper separator, the distance cannot exceed 40 dots
(Rightof the right border of the USeparator element, Offset = —20, Element Border = right, and Leftof the
right border of the USeparator element, Offset = -20, Element Border = right).

© 2009 ABBYY. All rights reserved. 29



FlexiLayout Studio 9.0 Tutorial

Now if you try matching the FlexiLayout with the images you will see that the program can detect these areas. In the Tree of
Hypotheses, right—click on a hypothesis and select Show Search Area in the local menu. If the search criteria are wrong and the
program failed to locate the search area propetly, you will immediately notice this. You may also see that even the search area of a
correct hypothesis needs some adjustment, e.g, it may be too small.

The maximum size of all the separators was detected by trial and error while studying the properties of Separator objects during pre—-
recognition.

To describe the YOUR PHOTO IN FANCY DRESS field:

L. Create an element of the Object Collection type and name it PhotoPicture.
2. On the Relations tab, specify the search area for the PhotoPicture element:

below the upper separator (Below the USeparator clement)
above the lower separator (Above the BSeparator element)

to the right of the left separator (Rigthof the LSeparator clement)
to the left of the right separator (Leftof the RSeparator clement)

Then create the PhotoPicture block and specify the PhotoPicture element as the source element.

Step 21. Exporting the FlexiLayout

Before you can use your FlexiLayout in ABBYY FlexiCapture, you must export it into AFL format:

1. Select the Export FlexiLayout... command in the File menu.
2. In the Export FlexiLayout dialog box that opens, enter a name for the file and select the folder in which to save the file.

The resulting "afl file can then be used in ABBYY FlexiCapture.

Step 22. Opening the FlexiLayout in ABBYY FlexiCapture

The FlexiLayout saved in "afl format can be opened in ABBYY FlexiCapture:

1. Launch ABBYY FlexiCapture.
2. Create 2 new project or open an existing project.
3. Create a new document template or open an existing template in the Template Editor.

[#Note: to open an existing template, go to Project>Document Templates..., sclect the required template from the list of available
templates and click Edit...

In the Template Editor, open the Section Properties dialog box (View>Properties...).
Click on the Flexible Description tab.

Click the Load... button.

In the Open dialog box that opens, select the required *afl file.

SN

[#Note: The required template blocks will be created automatically based on the FlexiLayout.
To view the blocks, select the Match Section command in the Tools menu.
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%, Helloween Form* - Document Template Editor |Z||E|[5__<|

Template Edit  Wiew Document  Tools  Help
Leg | £ G . :
B X @R X S g

OB & %] a v % w7 S]] 7| Docunent stuct.. X

Fieldz | Fages

NOTE:
Please remember that this form should be completed
by extraterrestrials only

- .i| Dacument Sectionl
d| PlanetMame
d | GuestMame
d | Spaceship
d| ArrivalDate
M| TdentityMurmber
d| TextField
k| PhotoPicture

NAME: MARTIAN THE FIRST]

YOUR PLANET NAME: :me.;t:

YOUR SPACESHIP NUMBER:

DATE YOU ARRIVED AT THE EARTH:

YOUR IDENTITY NUMBER ON THE PARTY IS:

|4

T h I ¢ | *

Zuts part from selected region | Document Sectionl: PlanetMame Text
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